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This presentation was created using 

Open Source Software

Open Office copyright is jointly held by Sun 
Microsystems and Contributors.

 
The software is distributed under the 

GNU Lesser General Public License Version 2.1.
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Open-Sourceness
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Open-Sourceness

● No controlling content (Let go!)
– Allowing redistribution

● Collaboration platform
– Improvement scheme
– Sharing improvements

● Building a shared resource
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Open Source
 Hardware
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Open Source Hardware

● http://www.openhardwarefoundation.org 

● Non-profit corporation 

● Whose charter is to promote the design and 
production of 
– open source and 
– open documentation hardware.  

http://www.openhardwarefoundation.org/
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Open Source
Graphics Card
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Open Source Graphics Card
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Open Source Graphics Card

● http://wiki.opengraphics.org/tiki-index.php 

● The Open Graphics Project (OGP) 
is developing 
– Graphics cards with 
– Fully published specs and 
– Open source drivers.

http://wiki.opengraphics.org/tiki-index.php
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Open Source Graphics Card

● List of Materials
http://spreadsheets.google.com/pub?key=ps980ejSIf3DeoBkURvDZQ

● Development Tools
http://wiki.opengraphics.org/tiki-index.php?page=Development_Tools

● Hardware Development Tools
http://wiki.opengraphics.org/tiki-index.php?page=Hardware+Development_Tools

http://spreadsheets.google.com/pub?key=ps980ejSIf3DeoBkURvDZQ
http://wiki.opengraphics.org/tiki-index.php?page=Development_Tools
http://wiki.opengraphics.org/tiki-index.php?page=Hardware+Development_Tools
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Open Source Phone
Freerunner
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Open Source Phone
Freerunner

● Linux-based 
● Touch screen 
● Smart phone
● Aimed at general 

consumer use 
● as well as Linux 

desktop users and 
software developers. 
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Open Source Phone
Freerunner

http://wiki.openmoko.org/wiki/Neo_FreeRunner_GTA02_Hardware

http://wiki.openmoko.org/wiki/Neo_FreeRunner_GTA02_Hardware
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Open Source Phone
Freerunner

● Openmoko
● Qt Extended (Qtopia) 

– Nokia-Trolltech
● Gentoo
● Debian
● Android (Google)

http://wiki.openmoko.org/wiki/Distributions 

http://wiki.openmoko.org/wiki/Distributions
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Open Source Beer
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Open Source Beer Project
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Open Source Beer Project
● http://www.opensourcebeerproject.com/

● “Flying Dog Brewery”

● Denver’s largest brewery and the second 
largest craft brewery in the state of Colorado.

● Sharing Beer recipes

● Collaborating on improving them. 

http://www.opensourcebeerproject.com/
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Free Beer Project
● http://freebeer.org/blog/about/

● FREE BEER
is a beer which is free in the sense of freedom, 
not in the sense of free beer.

● Conceived by 
– Copenhagen-based artist collective Superflex and
– Students at the Copenhagen IT University,

● Applies modern free software / open source 
methods to a traditional real-world product: Beer

http://freebeer.org/blog/about/
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Free Beer Project
http://freebeer.org/blog/recipe/

● VERSION 4.0, SEPTEMBER 2008
Codename: SKANDS

● INGREDIENTS

– MALT:
● 3,8 kg Maris Otter (3,0 SRM)
● 800 g Munich Malt (7,1 SRM)
● 200 g Crystal Malt (66,0 SRM)
● 100 g Brown Malt (95,4 SRM)
● 80 g Carafa Special Type III (710,7 SRM)

– HOPS:
● 7.48 AAU Northern Brewer hop pellets 

(FWH.)
● (25 g of 8.5% alpha acid)
● 2.92 AAU Williamette hop pellets (7 min.)
● (15 g of 5.5% alpha acid)

http://freebeer.org/blog/recipe/
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Open Source Games



 22

Fantastic Contraptions
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Fantastic Contraptions

http://fantasticcontraption.com/ 

http://fantasticcontraption.com/
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Fantastic Contraptions

● Roaming user
– 21 First levels
– See other people's solutions

● Subscriber ($10 one-time fee)
– Save your solutions
– See all existing levels (over 1000)
– Create you own challenges (levels)
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Fantastic Contraptions

● Quiz
– “Rolling Away”
– “Mind the Gap”
– “Back and Forth” (Bonus, 2nd page)
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Open Source Architecture
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Open Source Architecture

● One billion people live in abject poverty.
● Four billion live in fragile but growing 

economies.
● One in seven live in slum settlements.
● By 2030 it will be one in three.

http://www.architectureforhumanity.org/ 

What global housing crisis?

http://www.architectureforhumanity.org/
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Open Source Architecture
● Architecture for Humanity created the 

Open Architecture Network 
● The first site on the Web to provide access to 

open source architectural plans.
– embracing open-source technology 
– removing barriers to the improvement, 
– distribution, and 
– implementation of well-designed solutions, 

● Ensure that communities receive innovative, 
sustainable and, dignified shelter.

http://www.architectureforhumanity.org/ 

http://www.architectureforhumanity.org/
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Open Source Architecture
● Architectural Designs under

Creative Commons Licenses

● Cameron Sinclair (TED Video) (min 15 & 19)

● Lack of 
– Repositories
– Standard file formats
– Design applications

http://www.openarchitecturenetwork.org/ 

http://www.openarchitecturenetwork.org/
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Open Source Music
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ccMixter
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ccMixter

http://ccmixter.org/ 

● Post sound tracks
– Under Creative Commons licenses

● Remix them with other tracks
● Share the remixes
● Review / Rate
● Download and Redistribute Music
● All Legal  !

http://ccmixter.org/
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ccMixter

http://ccmixter.org/ 

● Drums
– http://ccmixter.org/files/Fireproof_Babies/11757 

● Synthetizer (think nuclear powered pipe organ) 
– http://ccmixter.org/files/bmccosar/14737 

● Remix with Guitar
– http://ccmixter.org/files/Pitx/17154 

● Remix with vocals (Wired but disconnected)

– http://ccmixter.org/files/duckett/17456 

http://ccmixter.org/
http://ccmixter.org/files/Fireproof_Babies/11757
http://ccmixter.org/files/bmccosar/14737
http://ccmixter.org/files/Pitx/17154
http://ccmixter.org/files/duckett/17456
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ccMixter

http://ccmixter.org/ 

● A Capellas
– http://ccmixter.org/files/silviao/9063 

● Smooth remix
– http://ccmixter.org/files/_ghost/12254 

● Cinematix Mix
– http://ccmixter.org/files/DJDecay/9122

● Soft Jazz (Good bye Mr. Rogers)
– http://ccmixter.org/files/cdk/12043 

http://ccmixter.org/
http://ccmixter.org/files/silviao/9063
http://ccmixter.org/files/_ghost/12254
http://ccmixter.org/files/DJDecay/9122
http://ccmixter.org/files/cdk/12043
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Kompoz
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Kompoz

● Kompoz is a social 
workspace for musicians 
and songwriters.

● Record with GarageBand, 
Pro Tools, etc. 

● Upload your tracks 
● Invite others to 

collaborate on your song 
idea 
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Kompoz

● Music CD created by 45 
musicians, 

● Who have never met, 
● Brought together in 

Kompoz.com. 
● Working from their homes 

all over the map
● These artists are defining 

the future of music.



 38

Kompoz

● “The Fall”
● http://cdbaby.com/mp3lofi/kompoz-04.m3u 

– Guillaume Muhlmann (Metz, France): Guitar
– Karl Knutson (Naperville, IL, USA): Vocals, Lyrics
– Pacal Lopez (France): Keyboards
– Matt Relstab (Portland, OR): Guitar

● Creative Commons License

http://cdbaby.com/mp3lofi/kompoz-04.m3u
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Kompoz

● “Down to the River”
● http://cdbaby.com/mp3lofi/kompoz-11.m3u 

– Raf Fiol (Miami, FL, USA): Lyrics, Rhythm Guitars
– Tommy Hall (Miami, FL, USA): Lead Guitar
– Karl Knutson (Naperville, IL, USA): Vocals
– Bjorn Pehrson (Stockholm, Sweden): Bass
– Jay Schankman (Kingston, OH, USA): Keyboards
– John Wooten (Kansas, USA): Drums

http://cdbaby.com/mp3lofi/kompoz-11.m3u
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Slice the Pie
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Slice the Pie

http://www.slicethepie.com/ 

● Artists can raise money directly from their fans 
to professionally record albums

● Fans can become emotionally and financially 
involved at all levels of the music industry 
– Scouting
– Breaking
– Investing in and 
– Influencing real artists

http://www.slicethepie.com/
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Slice the Pie

http://www.slicethepie.com/ 

● Investors can
– Gamble on
– Trade in and 
– Profit from the success of these artists

● Artists who secure finance 
– Pay Slicethepie a small royalty on album sales but
– Keep all their copyright and publishing rights.

http://www.slicethepie.com/
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Open Source Movies
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Elephants Dream
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Elephants Dream
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Elephants Dream
● The world’s first open movie

● Made entirely with open source graphics 
software such as Blender, and 

● With all production files freely available to use 
however you please, under a
Creative Commons license.
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Elephants Dream

● Created by the Orange Open Movie Project 
studio in Amsterdam during 2005/2006

● Bringing together a diverse team of artists and 
developers from all over the world
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Big Buck Bunny
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Big Buck Bunny



 50

Big Buck Bunny
● License information

The results of the Peach open movie project 
has been licensed under the Creative 
Commons Attribution 3.0 license. 

● This includes all the data published online and 
on the DVDs, and all of the contents on their 
website. 

● If any content on this site is not licensed as 
such, it will be clearly indicated.
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Big Buck Bunny
● You can freely reuse and distribute this 

content, also commercially, for as long you 
provide a proper attribution.

● The attribution is:
– a) If you redistribute or screen or broadcast the 

movie itself: include the entire credits scroll.
– b) In all other cases, attribute it as:

(c) copyright Blender Foundation
www.bigbuckbunny.org
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Big Buck Bunny – Production Files

scenes

sets chars props

envs mattes
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Big Buck Bunny – Production Files
● Create a new Blender scene AND save the file
● Delete the default cube object ( select and X)
● View -> Front
● Append the scene file from

– production/chars/
FlyingSquirrel.blend/Group/FlyingSquirrel

– Select: Relative Paths & Link, then click on 
– Load Library
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Big Buck Bunny – Production Files
● The character will not be visible yet.
● Shift + a

– Add -> Group -> FlyingSquirrel
● Correct Orientation

– View -> Side
– Hit “r”
– Hold CTRL and move mouse until it is up-right
– Left click to let it go.
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Big Buck Bunny – Production Files
● Select Wireframe Visualization
● Make it local (or Proxy)

– Ctrl+ Alt + p
– Select FlyingSquirrelRig

● Select “Pose” mode
– Select any bone (right click on it)
– Move it around (mouse)

● “r”  rotate in one axis
● “r r” rotate in two axes
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Big Buck Bunny – Production Files
● More instructions on the Tutorials in the DVD

● Additional Tutorials in the “Help” menu.

● Remember to give credits to 
the Blender Foundation 
in order to comply with the License.
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End


